
After the WinTV-USB driver has been loaded, the WinTV
setup program will be run.

Chose the language you would like and click Next.

Click Install.

After all of the files have been installed, you will
see the Installation Complete message.
Click OK.

USB-Live video adapter 

USB-Live Installation CD-ROM with:

WinTV-32 application

WinTV-2000 application with
SoftPVR™

Microsoft NetMeeting updates for
Windows98

DVD MovieFactory 2SE for editing
and burning Video CD’s and DVD’s

Contents of the USB-Live package

DO NOT PLUG THE USB-Live into your PC until your PC has fully booted..

Turn on and boot into Windows. 

Then plug the USB-Live into one of the USB connectors on the back of your PC.

Note: it is not recommended to connect the WinTV USB to a USB Hub or Keyboard

Step 1: Boot your PC

Page 2 Page 3 Page 4

Step 2: Install the USB-Live driver for WindowsXP  
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Note: DO NOT INSTALL USB-Live until your PC has been
turned on and Windows has booted.

Step 3: Install the WinTV application

Now connect a VCR, camcorder or video camera to the
WinTV-USB connector marked VID-IN for Composite
video (RCA) or SVid-IN for S-Video.

Step 4: Connect the video  

On your Windows desktop, you will see an icon for the WinTV2000 application. To launch
WinTV2000, simply double click on its icon on your Windows desktop. If you get an error
message, please review the Troubleshooting section.

The WinTV2000 application

Step 5: Running the WinTV application

Hauppauge!®

USB-Live
Quick Installation Guide

for WindowsXP
The full manual in PDF format is located on the USB-Live Installation CD, in the
MANUAL directory.

USB-Live will operate with Windows98SE, WindowsMe, Windows2000 and WindowsXP.

VID-IN
(RCA)

SVID-IN

When the Found New Hardware Wiz-
ard appears, Insert the WinTV Installa-
tion CD-ROM in your PC’s CD-ROM drive
and make sure Install the software
automatically (Recommended) is
checked.

Then click NEXT.

When the Hardware Installation dialog
box opens, click Continue Anyway.

The USB-Live driver will be copied to your
hard disk drive.

Click Finish.
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Double click on
each "thumbnail" to
see image full size.
Click and hold your
right mouse button

to see image
options.

Current TV channel
or video source

Click your right mouse
button here to see the

channel selector

Remove toolbars
Click your right mouse button in the TV

window to remove toolbars. 

Click again to restore toolbars.

One Touch
Record

New features on the WinTV2000 application

Selecting an External Video source (VCR, camcorder, etc.) 

Click the green Video source select button to select Composite or S-Video sources. The
video sources will use the video standard chosen (NTSC or PAL).

Displaying TV full screen

When you click the Full screen button, video will appear full screen. When finished watching
video full screen, click your right mouse button in the video window.

If you see video with a black box around it, click the Pref button then click TV mode tab. Check
the box which says "Allow resolution change". 

"Always-on-Top" mode:

With Always on Top, the WinTV window can always be visible on your Windows desktop. To
turn on Always-on-Top, simply click the Always-on-top button. It will turn green. To turn off
Always on Top, click this button again.

A convenient way to use Always-on-Top is to make the TV window in the no-title mode small,
and to make the TV window in the title mode larger. Then you can switch very quick from a
small window to a larger one simply by clicking the right mouse button.

Menu button

Click the Menu button to open the TV Setup menu:

Suite Manager: not used on the USB-Live (this is for WinTV’s which have built-in TV tuners).

Configuration: duplicate configuration menus for color, audio, MPEG settings, etc.

View: for setting the TV window size

Pref button

Click the Pref button to open the Preferences menu. You will have tabs for:

View: these are the settings for the On Screen Display of the TV channel and Audio Vol-
ume, where you can enable Close Captions, plus controls for the Toolbar mode (Title
mode), NoToolbar mode (No Title) and Full Screen (TV mode).

Movies: here is where you configure the video and audio settings for SoftPVR.  You can set

the movie record directory (DVCR Record File Path), the MPEG Quality settings, and
the Audio setings.

Snap Shot: here is where you can set the size of your captured images plus single or two
field captures.

Audio: your audio settings are configured here.

Color: adjust the color of your TV picture here.

To hide the WinTV toolbar: 

Simply click your right mouse button in the WinTV’s video window for the no-title mode. To
restore the toolbars (the title mode), once again click your right mouse button in the
WinTV’s video window. You can set the size of the window differently in each mode.

To allow WinTV to display TV full screen: 

Click on the Pref button in WinTV2000 (or click on Display / Preferences in WinTV32), then
click TV mode, and check the box which says “Allow resolution change”. When you click the
Full screen TV button on WinTV2000, Windows will change your screen resolution to either
640x480 and TV will appear full screen.

When finished watching TV full screen, click your right mouse button to return to “TV-in-a-
window” mode.

Recording MPEG video with SoftPVR™

Note: The following functions are not currently enabled with SoftPVR: the OTP and Pause
buttons, plus the Fast Forward and Rewind functions.

Note: a Pentium III 800MHz minimum system is recommended for best SoftPVR operation.

To start recording, either click the OTR (One Touch Record) or the red Record button on
WinTV2000. You can also start a recording by using WinTV Scheduler.

To stop recording, click Stop. To close the recording controls, click the TV mode button.

If you click OTR more than once, a record timer will be set and the record timer will be set
15 minutes for each time the OTR button is clicked. For example, if you click the OTR but-
ton 3 times, the WinTV will record for 30 minutes.

The recorded video file is saved in the DVCR Recorded File Path directory. To set this
directory, click the PREF button (Preferences menu), then the Movies tab. In DVCR Record
Path set the directory for your recordings.

Record Button: Clicking the Record button will automatically generate a file name
and start recording your audio/video program. Everytime you record a file, a new file
is automatically created and the file name is displayed in the record window. The first
file name will be _dvcr001.mpg. The second file will be _dvcr002.mpg and so on.

While recording:

- Live video continues to play in the WinTV window

- The Counter will display the length of your recording in hours:minutes:seconds

- If you had started recording with the OTR button, and had clicked it more than
once, the total time for the recording will also be displayed. You can also
click OTR after a record has been started, and the record timer will be set. 

Click the Stop button to stop your recording. The recorded audio/video file is then saved to
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1. If you receive any of the following error messages, your VGA card does not support
Overlay Mode and therefore you must run Primary.EXE from the WinTV directory,
selecting Primary:

black screen (no video image)

excessively slow and/or pixelated TV image

Error message: “Connecting Preview Pin Direct to Overlay Mixer”

2. If you receive any of the following error messages, your USB-Live driver was not
loaded correctly:

“Error Cannot Locate Capture Filter (Hauppauge WinTV capture)”

“Cannot build filter graph”

“Error: connecting VCap and HCWcapt filters”

“Error preview pin direct to overlay mixer”

To fix this problem, run HCWCLEAR.EXE which can be found in the Misc\Utilities
director of the WinTV-USB Installation CD-ROM.  Then remove the USB-Live device
and reboot your PC. 

After reboot, the WinTV-USB driver will reload. The latest version of the WinTV-USB
driver can be found on our Web site at
http://www.hauppauge.com/html/sw_tvusb.htm

3. To verify that you have Windows 98 and above operating system, click on Start/Set-
tings/ControlPanel then click on the System icon. In the General tab under Sys-
tem you should see Microsoft Windows98 Version 4.10.1998 or Microsoft Win-
dows98 Second Edition.

4. To insure that you have USB support, click on Start/Settings/ControlPanel then
click on the System icon. Under the Device Manger tab you should see that you
have a Universal Serial Bus Controller.

5. To check if your installation was successful,  click on Start/Settings/ControlPanel
then click on the System icon. Under the Device Manger tab go to Sound, Video
and Game Controllers and check that it has the line: Hauppauge WinTV-USB.

6. WinTV USB-Live will not run under Windows95 or Windows NT4.0

7. When video is running, Windows will not enter suspend mode.

8. If the live video display freezes when you open other applications, you should
reduce the Hardware acceleration of the PC Display Adapter (this may happen
only on several specific display adapter cards). Go to Control Panel and click on
Display. Select 'Setting', then click on Advanced Properties, select the Perfor-
mance tab and you will see the Hardware acceleration bar. Reduce the perfor-
mance to None. 

9. Note that if Overlay mode is selected, no live video is displayed during video cap-
ture or video streaming (video streaming is used by some Videoconferencing and
Video Mail applications). 

10. Turn off the PC power manager to achieve better performance, located in control
pannel.

Troubleshooting

The latest drivers, installation notes and Utilities are available on the Hauppauge Software
Updates page on the Hauppauge web site. Please look at 
http://www.hauppauge.com/html/sw_tvusb.htm

1. Microsoft’s NetMeeting can be run with the WinTV-USB-Live. Here are some known
problems:

If you are using Windows98 Second Edition (which was released June 1999) with Net-
Meeting 3.0, you cannot change the source for the video from within NetMeeting. This is
a NetMeeting problem which will be fixed in the future. To change sources, you need to
set the source in  WinTV32,  Win2000. close WinTV and then run NetMeeting.

If you are using the original version of Windows98, to use NetMeeting you will need to
run a NetMeeting upgrade program. This can be found on the WinTV-USB Installation
CD-ROM in the Misc\VFW_upd directory. Run the VFWUPD.EXE program from this
directory. 

Capturing motion videos (AVI files) is simple with USB-Live.  Use the integrated software
remote control in the WinTV2000 application (click the RC button on WinTV2000) to config-
ure and activate these functions.  WinTV32 has identical features, which can be selected
from the still camera and movie camera buttons provided on the top of the WinTV toolbar.

After capturing AVI video files, you can bring them into DVD MovieFactory for editing or
burning. To edit, use the Capture Video menu, click on the Edit tab, and then click the
Import video files button. To burn onto CD, use the Author menus.

Still Image Capture: Multiple still images can be captured, allowing you to select or dis-
card images and adjust the image size before saving.  Use the CFG button to set the
default image size (the image size can also be changed by clicking the right-hand
mouse button on a chosen image).

Motion File Capture: The buttons under the VCR section are numbered to aid clarity.
Firstly, click on FILE, to set the Name and Location of the file that you want to create, for
example: TEST.AVI in C:\ (as shown, we recommend adding the .avi extension at the
end of the file name).  Click on FMT to set the Video Format, Frame Size and Frame
Rate (typically: 15-bit RGB, 320x240 and 25 frames per second, respectively).

To start Recording, click on REC.  To stop Recording, click on REC again. A file name
ending with the extension .AVI will be created and copied to your hard disk.  To play
back the recorded file, simply click on the PLAY button.  Alternatively, locate the file and
double click on it.

Warning: Motion (avi) files can consume a large amount of disk space; typically 100MB per minute.
Note: If you find that there is no Audio during Playback, this is because the sound card has
not been setup to record audio from its 'line-in' socket. Generally, you will need to will need to
go to Start/Programs/Accessories/Entertainment/ VolumeControl. This will dis-
play the Widows Volume Control panel, where you should click on Options, then
Properties, then select Recording and make sure that at the bottom 'Line-in' is checked (this
is sometimes called 'Line' or 'Aux'. Clicking on OK will return you to the Volume Control
Panel 
(for recording levels). Make sure that 'Line-in' (or 'Line' or 'Aux') is selected and that the Vol-
ume Level is set high.

Video Capturing Procedure

Notes

Online Help

Keyboard shortcuts

Ctrl C Image Copy to the clipboard
Ctrl F Image freeze
Alt M Default Menu
Ctrl P Image print
Ctrl T Full screen video

F1 Help
SHIFT / F1 Context Help

In the Add New Channel dialog box,
you should:

Set Channel Number to 1

Set Channel Name to either 
Composite or S-Video

Set Preset to 1

Set Video Format to PAL

Then click Add.

You will now have the video
input source correctly config-
ured for your video standard.

Configuring WinTV for PAL video

In Europe and other areas
which use PAL video, you need
to change the video format to
PAL. 

To do this, click the Suite but-
ton (on the WinTV32 applica-
tion click Configure / Channels
/ SuiteManager). Click Add and
chose either Composite or S-
Video (depending upon which
type of video you are using).

Should you require information regarding the use of features in the WinTV 2000 applica-
tion, we have provided an on-line HELP button.

You can get to this by clicking on the lower-right hand corner of the WinTV 2000 applica-
tion window to launch the “virtual remote control”.

The HELP button is located at the bottom of the advanced controls
section of this remote control (see left)

Note: The USB-Live comes with the same highly-acclaimed WinTV
application that we supply with our other WinTV products. Because
of this, some features (namely: tuning for TV channels) are not
applicable to this product.

Start project: Used to author and burn DVD’s, SVCD’s and VCD’s. Create chapter menus,
mix videos, JPEGs and music. 

Edit disk: Edit videos or menus from DVD+RW’s.

Direct to disk: not used.

Copy disk: Burn copies of existing disc images to CD/DVD.

Burn disk images: Burn copies of existing disc images to CD/DVD.

Using DVD MovieFactory 2SE
disk using the automatically assigned file name. The Time counter is reset to 00:00:00
after the recording is saved.

Play Button: Clicking the Play button will playback from disk the last video file
created. With SoftPVR, you can only Play and Pause your videos.

File Button: Clicking the File button opens the File menu. The last file recorded
is listed in the File name box. In the File menu you can: Rename your recorded
video file, Play a video file previously recorded, Delete recorded video files.

If you have problems with audio: 
If you find that there is no audio while playing back your AVI files, this is because the
sound card has not been setup to record audio from its 'Line-in' socket.  To enable
audio recording, open the Recording Control panel by clicking Start / Run and then
SNDVOL32 /REC This will open the Recording Control panel. Make sure that 'Line-
in' is enabled (this is sometimes called 'Line' or 'Aux').


